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User Console

This page allows you to display all documents currently assigned to the login ELSIG and all unassigned documents within any workgroup to which the login ELSIG belongs that need to be certified. 

The data displayed on this page is retrieved from the Document Status History table and is determined by the login ELSIG. This page allows you to view ten rows at a time and each row displays brief information about a member's record. The records are listed oldest to newest, and the first byte of the SSN on the record is always zero. 

The Preparer can view only documents that the Preparer created that have not been sent to the Certifier. The Certifier can view only documents assigned to the Certifier for certification.

How Do I Get Here?

1. Begin on the ELSIG login page.
2. Follow the steps in the Document Tracking and Management System Login topic, in the To Login to Document Tracking and Management System section. The User Console page displays.

OR

· On any DTMS page, from the menu, choose DTMS Home.

This page displays the following information:

Header

· User Name (First Name, MI, Last Name)

· RUCNNNNN

· Title (User Console)

Body 

· Date Document Created (YYYY/MM/DD)

· Member SSN (####-##-###)

· Member Name (Last Name, First Name, MI)

Navigation

· Top

· Previous

· Next

· Bottom

Section Assignments

· Section Assigned To:

· Date Document Created (YYYY/MM/DD)

· Member SSN (####-##-###)

· Member Name (First Name, Last Name, MI)

· Document Type

· Document Status

To View the Document

· Choose the Member Name on the desired record. The Document page displays.

Note:If the document is an Advisory Notice, then zeroes display under SSN and Advisory Notice displays under Member Name.

To View the Document History

· Choose View History on the desired record. The Document History page displays.

To Print a Document Page

· On the record you want to print, choose Print Document. The Document page displays.

To Change Your Location on The Web Page:

1. To move to the First ten Rows, choose Top.  Your cursor moves to the first record of the first ten rows on the list.

2. To move to the Previous ten records, choose Previous. Your cursor moves to the first record of the previous ten records.

3. To move to the Next ten records, choose Next.  Your cursor moves to the first record of the next ten records on the list.

4. To move to the Last ten records, choose Bottom.  Your cursor moves to the first record of the last ten records on the list.

5. To view the Updated Version of this web page without leaving the page, from the browser, choose Refresh.  The updated version of this web page displays.

Document Flow

If the document is created by or assigned to the Admin Preparer:

It displays on the Admin Preparer's user console and can be:

· Edited and forwarded for review.

· Deleted if not previously certified.

If the document is forwarded for review:

It displays on the Admin Reviewer's and Admin Certifier's user console and can be:

· Deleted if not previously certified.

· Killed if previously certified.

· Returned to the Admin Preparer for additional work.

· Released to the Certifier by the Admin Reviewer.

· Certified by the Admin Certifier and forwarded to Disbursing. 

Note: If the document was previously returned from Disbursing with a discrepancy notice, the Admin Certifier must update the notice status with a comment.

 

If the Document is released to the Certifier:

It displays on the Admin Certifier's user console and can be:

· Deleted if not previously certified.

· Killed if previously certified.

· Returned to the Admin Preparer for additional work.

· Certified by the Admin Certifier and forwarded to Disbursing.  If the document was previously returned from disbursing with a discrepancy notice, the Admin Certifier must update the notice status with a comment.

Note: A document certified by Admin is automatically forwarded to Disbursing.

If the Document is forwarded to Disbursing:

It displays on the work-pool user console and can be:

· Assigned to the Disbursing Preparer by the Disbursing Auditor or Disbursing Certifier who is assigning the document to the Disbursing Preparer.

· Assigned to the Disbursing Preparer by the Disbursing Preparer assuming responsibility of the document.

· Forwarded with the discrepancy noted by the Disbursing Auditor to the Disbursing Certifier.

· With the discrepancy notice attached, returned by the Disbursing Certifier to Admin.

If the Document is assigned to the Disbursing Preparer:

It displays on the Disbursing Preparer user console and can be:

· Worked and forwarded for review.  The comment should indicate whether a discrepancy is noted.

If the Document is forwarded for review:

It displays on the Disbursing Auditor and Disbursing Certifier user consoles and can be:

· Returned to the Disbursing Preparer for additional work.

· Forwarded by the Disbursing Auditor to the Disbursing Certifier for 11116 documents. A comment should indicate whether a discrepancy is noted.

· With a discrepancy notice attached, returned by the Disbursing Certifier to Admin.

· Certified by the Disbursing Certifier.

· Forward for zero-balance (11060)

If the Document is forwarded to the Disbursing Certifier:

It displays on the Disbursing Certifier's user console and can be:

· Returned to the Disbursing Preparer for additional work.

· Returned to Admin with a discrepancy notice attached.

· Certified by the Disbursing Certifier.

If the Document is returned to Admin:

It displays on the work-pool user console and can be:

· Assigned to the Admin Preparer by the Admin Reviewer or Admin Certifier who is assigning the document to the Admin Preparer.

· Assigned to the Admin Preparer by the Admin Preparer that assumes responsibility of the document.

· Forwarded with a response by the Admin Reviewer to the Admin Certifier.

· Killed by the Admin Certifier for the unit that generated the document.

· Closed by the Admin Certifier for the disbursing unit.

· Updated in the instruction section, re-certified, and forwarded to Disbursing by the Admin Certifier.

Document Status

This function allows you to see where the document is in the work process.

To View a Document Status

· To view the status of the 11060 or 11116 document, in the User Console page, see the "status" field.

Document Assignment

This page allows you to assign an electronic document to a specific user or previously defined workgroup and allows you to sort the documents by different categories.

How Do I Get Here?

1. Begin on any Document Tracking and Management System page.

2. From the Tools menu, select Document Assignment. The Document Assignment page displays.

This page consists of the following information:

Header

· User Name, of RUC

· Title - Document Assignment

Body

· Last Certified Date (This is the last time the originating unit forwarded the document to the receiving unit)

· Document Created Date

· SSN

· Member Name

· Assign(ed) To

To Assign Documents

1. In the Sort by box, select the field you want the documents to be sorted by. The default is Current Preparer.

2. In the Ascending checkbox, do one of the following:

3. To sort the documents in ascending order, select the checkbox.

4. To sort the documents in descending order, clear the checkbox.

3. In the Assign(ed) To box, do one of the following:

4. To assign the document to another person or section, select the name or section.

5. To unassign a document, select Unassign Document.

4. Choose Apply Changes. The documents are sorted in the applicable order.

Document Self Assignment

This page allows you to assign an electronic document to a specific user or previously defined workgroup.

How Do I Get Here?

1. Begin on the User Console page.

To Self Assign a Document

1. From the work pool list, choose a Member Name. A message prompts you to choose whether you want to assign the document to yourself.

2. Do one of the following:

· To assign the document to yourself, choose OK. The document is assigned to you and is visible on your user console.

· To leave the document unassigned, choose Cancel. The document stays in the workpool, unassigned.

3. You return to the User Console page.

Input SSN

This page allows you to input a Social Security Number to search for documents submitted for that one SSN. If the member's record is not available, a message informs you the member was not found, and to continue, you must type another SSN. If the SSN does not exist on the database, the SSN Search page displays with no information.

How Do I Get Here?

1. Begin on the User Console page.

2. From the Tools menu, choose SSN Search. The Input SSN page displays.

How To Input an SSN

1. In the Service Code and SSN box, the member's one-digit Service Code is automatically populated. Type the member's nine-digit Social Security Number.

2. Choose Search. The SSN Search page displays.

SSN Search

This function allows you view documents related to a specific SSN, and it's history. The document page can also be printed.

The buttons at the bottom of the page allow the user to move through the document list.

How Do I Get Here?

1. Begin on the Input SSN page.

2. In the Service Code and SSN box, the member's one-digit Service Code is automatically populated. Type the member's nine-digit Social Security Number.

3. Choose Search. The SSN Search page displays. If the SSN is not on the database, the page displays with no information. To continue, from the Tools menu, choose SSN Search. 

The following information displays:

Header

· User Name, of RUC or DSSN

· Title (SSN Search)

Body

· Documents For

· Member Name

· Member SSN

· Document Created Date

· Document Type

· Document Status 

· View History

· Print Document

At the Bottom

· Top

· Previous

· Next

· Bottom

To View the Document

· Choose the Member Name on the desired record. The Document page displays.

To View the Document History

· Choose View History on the desired record. The Document History page displays.

To Print a Document Page

· Choose Print Document on the desired record. The Browser Print window displays.

NAVMC 11116: Miscellaneous Military Pay Order and Special Payment Authorization

This page allows an administrative office or a disbursing office to view the Miscellaneous Military Pay Order and Special Payment Authorization (NAVMC 11116) authorizing payment to a member. Only the selected options display.

When the document is viewed by the disbursing office, if another action is found to be necessary, an advisory notice may be attached to the document and the document returned to the Admin office. 

How Do I Get Here?

1. Begin on the User Console page.

2. From the Listing, choose the member's Name of the 11116 record you want to view. The document page displays.

This page consists of the following information:

Header

· SSN

· AdminRUC

· DSSN

· Name

· Reporting Unit Code

· Expiration of Current Contract

Payments

· Special Payment

Adjustments

· Advance Pay

· Pay Months

· Repayment Months

· Authorization

· Advance Housing Allowances

· Pay Months

· Repaid Months

· Authorization

· Estimated Move-In Date

· Currency Type

· Rent Amount

· Security Deposit

· Additional Moving Expenses

· Instructions/Other

Diary Transaction Information

· Transaction Document Id Number

· Diary Generated Date (YYYY/MM/DD)

· TTC number

· TTCSEQ number

· Description

· Add Transaction

· Delete TTC Transaction

Other Options

· Depending on the status of the document, and on the login ELSIG, choose the desired option.

· Add Document
· Add/Forward for Review
· Attach Files 

· Close Document
· Delete Document
· Document Comment
· Duplicate Document
· Forward for Zero Balance Audit

· Forward to Reviewer
· Forward to Certifier
· Kill Document
· Return to Admin
· Return to Preparer
· Return to Originating Admin
· View Attached Files
NAVMC 11060: Separation and Travel Pay Certificate

This page allows an administrative office or a disbursing office to view the Separation and Travel Pay Certificate which authorizes payment to a member. Only the selected options display.

When the document is viewed by the disbursing office, if another action is found to be necessary, an advisory notice may be attached to the document and the document returned to the Admin office. 

How Do I Get Here?

1. Begin on the User Console page.

2. From the Listing, choose the member's Name of the 11060 record you want to view. The document page displays.

This page consists of the following information:

Header

· Title (Separation/Travel Pay Certificate)

· SSN

· Admin RUC

· DSSN

· Name (Last Name, First Name, MI)

· Reporting Unit Code

· Expiration of Current Contract

· Unit Address

· Effective Date of Separation from Active Duty

· Program Designator

· Reason

· Type of Discharge

· Home of Record

· Place From Ordered to Active Duty

Pay Information

· Recoup Enlistment Bonus/Recoup Re-enlistment Bonus

· Authorization

· Lump Sum Leave

· Number of Days

· Previous LSL Used

· Authorization

· Leave Computation

· Balance

· As Of Date

· Unreported Leave

· Computed Leave Balance

· Leave Awaiting Separation

· Number of Days

· Permissive TAD Days

· Departure Date

· Authorization

· Pay Separation Pay

· Active Service Years and Months

· Authorization

· Pay Disability Severance Pay

· Active Service Years and Months

· Authorization

· Loan Recoup

· Type of Loan

· Loan Info

· Other

· Description

· Accounting/Appropriation Data--Accounting Clarification for Separation without Orders

· Appropriation Symbol and Subhead

· Object Class

· Bureau Control Number

· Sub Allotment

· Authorization Accounting Activity

· Transaction Type

· Property Accounting Activity

· Cost Code(s)

PART II - Marine Section

· Appellate Leave

· As of Date

· Voluntarily on Leave for number of Days

· Involuntarily on Leave for number of Days

· Previous Lump Sum Leave used 

· I Elect Payment Of number of days Lump-Sum Leave

· I elect to be issued Government Transportation Request (s) for travel and my expenses

· From Location

· To Location

· I elect to be paid advance separation travel allowances for myself and my dependents

· From Location

· To Location

· By Mode of Transportation

· Submit Claim To Address

· Permanent Mailing Address

· E-mail Address

· Contact Phone Number

Diary Transaction Information

· Transaction Document Id Number

· Diary Generated Date (YYYY/MM/DD)

· TTC number

· TTCSEQ number

· Reported Description

· Add Transaction

· Delete TTC Transaction

Other Options

· Depending on the status of the document, and on the login ELSIG, choose the desired option.

· Add Document
· Add/Forward for Review

· Attach Files

· Close Document
· Delete Document
· Document Comment
· Duplicate Document
· Forward to Certifier
· Forward to Reviewer
· Kill Document
· Return to Preparer
· Return to Admin
· View Attachments
Create Document

This page allows the Admin Preparer and Disbursing Preparer ELSIGs to create a new document and to link it to any electronic document assigned to them, or to any group that they are a member of, to complete actions for this form.

How Do I Get Here?

1. Begin on the any Document Tracking and Management System page.

2. From the File menu, select New Document and then do one of the following:

3. To create a Miscellaneous Military Pay Order or Special Payment Authorization, choose NAVMC 11116. 
4. To create a Separation or Travel Pay Certificate, choose NAVMC 11060. Only one separation or travel pay document per member should be created within a 30 day period. If you attempt to create a second document, the History document displays any existing NAVMC 11060 document.

3. The Input SSN page displays.

To Create A Specific Document
1. In the SSN box, type the Service Code and the SSN of the member for which you want to create a new document.

2. Choose Create. The applicable Document page displays, or a message informs you the SSN was invalid. If the SSN is invalid, you must begin again from How Do I Get Here? previously mentioned on this page.

Create 11116 Document

This page allows an administrative office to create the Miscellaneous Military Pay Order and Special Payment Authorization (NAVMC 11116) document for a member.

This page allows the Admin Office to link to any electronic document assigned to it or any group that it is a member of. The Admin Office can add the document to the Document Tracking and Management System database, add a comment to the document, and add and forward the document for review. Supporting documents necessary to conclude actions for this form are attached by links and are stored on the Document Tracking and Management System database. Depending on the login ELSIG, a document options menu displays to enable you to continue the document processing.

To Create a NAVMC 11116:

The fields in the Header section are automatically populated from the ODSE database. In the Payments and Adjustments sections, only when a payment type selection is made are the fields applicable to that payment type available for input by the user.

Header

1. SSN is used as the key for deriving information from the ODSE database.

2. AdminRUC is not editable.

3. DSSN is only editable by Admin Reviewer ELSIGs or Certifier ELSIGs.

4. Name is editable.

5. Reporting Unit Code is editable.

6. Expiration of Current Contract is editable. If the member does not have an ECC on the ODSE database, the field contains yyyy/mm/dd to prompt the user to input the date.

Payments

· If applicable, check the Special Payment box.

Adjustments

1. If applicable, check the Advance Pay box.

2. From the Pay list, select the Number of months the advance pay is incident to PCS orders. Valid values are one to three, and the default value is one.

3. From the Repayment list, select the Number of months in which the advance pay is to be repaid. Valid values are one to twenty-four, and the default value is twelve.

4. In the Authorization box, type in free form text, the Information to justify the payment or adjustment, up to 50 characters.
5. If applicable, check the Advance Housing Allowances box.

6. From the Pay list, select the Number of months of advance pay to be paid. Valid values are one to three, and the default value is three.

7. From the Repaid list, select the Number of months in which the Advance Housing Allowance pay is to be repaid. Valid values are one to twelve, and the default value is 12.

8. In the Authorization box, type in free form text, the Information to justify the payment or adjustment, up to 50 characters.

9. In the Estimated Move-In Date box, type the date estimated to move in.

10. In the Currency Type list, select the Currency Type that is used to pay the housing allowance as indicated in the lease. US Dollar is the default value.

11. In the Rent Amount box, type the Monthly Rent Amount in 99999999.99 format up to ten digits.

12. In the Security Deposit box, type the Amount of the security deposit in 99999999.99 format, up to ten digits.

13. In the Additional Moving Expenses box, type the Amount of additional moving expenses, in 99999999.99 format, up to ten digits.

14. In the Instructions/Other box, with up to 3800 characters, type Information or Instructions to enhance or clarify information provided on this form, or to add relevant information that falls outside of the realm of the categories on this form.
Diary Transaction Information

If anything is entered in this section, the Number field and the Date field are required to be entered by the Admin Preparer. It is not required by the Disbursing Preparer but must be entered for the document to be certified.

1. In the Number box, type the five-digit diary Transaction Document ID number.

2. In the Date box, type the Diary Generated Date in YYYY/MM/DD format. 

3. In the TTC box, type the three-digit TTC number.

4. In the SEQ box, type the three-digit TTCSEQ number.

5. In the Reported box, type the Description of the transaction up to 350 characters.

6. Choose Add Transaction. The Transaction is updated and displays beneath Add Transaction. A selected check box displays to the left of the transaction.

7. If you want to Delete a TTC Transaction, check the applicable Check Box. The transaction no longer displays when the document is updated.

Other Options

1. Do one of the following:

2. To Add a document, choose Add Document. The document is added to the database.

3. To Add a Document Comment, choose Document Comment. The comment is attached to the current document.

4. To Add or Forward a document for review, choose Add/Forward for Review. The document is added to the database and forwarded to the appropriate section.

2. You return to the User Console page.

Create 11060 Document

This page allows the Admin Preparer level Authority ELSIGs  Electronic signatures and the Admin Certifier level Authority ELSIGs to create the new Separation and Travel Pay Certificate (NAVMC 11060) document; however, the Admin Certifier level Authority ELSIGs cannot enter data.

This page allows the Admin Office to link to any electronic document assigned to it or any group that it is a member of. The Admin Office can add the document to the Document Tracking and Management System database, add a comment to the document, and add and forward the document for review. Supporting documents necessary to conclude actions for this form are attached by links and are stored on the Document Tracking and Management System database. Depending on the login ELSIG, a document options menu displays to enable you to continue the document processing.

Only one document is allowed to be created on any one member in a 30 day period.

To Create a NAVMC 11060:

The fields in the Header section are automatically populated from the ODSE database. In the Pay Information and Part II - Marine sections only when a payment type selection is made are the fields applicable to that payment type available for input by the user.

Header
1. The SSN is used as the key for deriving information from the ODSE database and is not editable.

2. The Admin Reporting Unit Code is based on the member's RUC.

3. The DSSN is not editable.

4. The Name is editable.

5. The Reporting Unit Code is used to drive the unit block information.

6. The Expiration of Current Contract is editable.

7. The Unit Address is automatically populated based on the member's RUC.

8. The Effective Date of Separation from Active Duty is automatically populated in YYYY/MM/DD format and is not required for appellate leave separations.

9. In the Program Designator list, select the Code that describes the type of separation the member is taking, choose OK. You return to the 11060 document. The default value is MBK1-SEPARATION CODE MBK1.

10. In the Discharge Reason list, select the applicable discharge reason.

11. In the Type of Discharge list, select the type of discharge the member is taking. The default value is General.

12. The Home of Record is automatically populated.

13. In the Place From Ordered To ACDU box, type the Duty Station from which the member was ordered to active duty.

Pay Information

The Admin Preparer or Certifier must enter the information in this section. If a box is checked, the information for that option must be completed.

1. If applicable, check the Recoup Enlistment Bonus/Re-enlistment Bonus check box.

2. In the Authorization box, type the Authority that directed the enlistment bonus or reenlistment bonus recoupment entitlement, up to 50 characters.
3. If applicable, check the Lump Sum Leave check box.

4. From the Number of Days list, select the applicable Number of lump sum leave days. Valid values for this field are zero to 60, and is chargeable in five-tenths of a day increments in xx.x format. If applicable, updates to this field automatically reflect in the Number of Days field for Leave Awaiting Separation pay type. The default value for this field is 0.5.
5. The Previous LSL Used is not editable.

6. In the Authorization box, type the Authority that directed the lump sum leave entitlement, up to 50 characters
7. From the Leave Computation Balance list, choose the applicable Number of the balance of leave days.

8. In the Leave Computation As Of box, type the begin Date of the leave computation in YYYY/MM format.

9. From the Leave Computation Unreported Leave list, choose the applicable Number of unreported leave days leave. The Leave Computation Computed Leave Balance is automatically populated.

10. If applicable, check the Leave Awaiting Separation check box. To use this option, the required information must have been entered into the leave computation module that determines the member's correct leave balance.

11. From the Number of Days list, select the applicable Number of leave awaiting separation days. Valid values for this field are one to ninety in xx.x format. If applicable, updates to this field automatically reflect in the Number of Days field for Lump Sum Days pay type.
12. From the Permissive TAD Days, choose the applicable Number of permissive temporary active duty days.

13. The Departure Date box is automatically populated with the appropriate Date, in YYYY/MM/DD format, when the Number of Days leave to be taken is input.
14. In the Authorization box, type the Authority that directed the leave awaiting separation entitlement, up to 50 characters.
15. If applicable, check the Pay Separation Pay check box.

16. From the Active Service Years list, select the applicable Number of years of separation pay. Valid values are six to nineteen, and the default value is six.
17. From the Active Service Months list, select the applicable Number of months over the number of years of separation pay. Valid values are zero to eleven, and the default value is zero.

18. In the Authorization box, type the Authority that directed the separation pay entitlement, up to 50 characters.
19. If applicable, check the Pay Disability Severance Pay check box. The member must have completed six months of service to be eligible for this entitlement.

20. From the Active Service Years list, select the applicable Number of years of disability severance pay. Valid values are zero to nineteen, and the default value is zero.

21. From the Active Service Months list, select the applicable Number of months over the number of years of disability severance pay. Valid values are zero to eleven, and the default value is zero.

22. In the Authorization box, type the Authority that directed the disability severance pay, up to 50 characters.
23. If applicable, select the Loan Recoup check box.

24. In the Type list, select the applicable Type of loan.

25. In the Info box, type the Authority that directed the loan recoupment, up to 50 characters.
26. If you have information to add that is not applicable to the other categories, select the Other check box.

27. In the Description box, type a Description of the information and the Authority that directed the Other pay, in as many characters as necessary.
28. The following Accounting and Appropriation Data - Accounting Classification for Separation Without Orders information is automatically populated from the ODSE database.

29. Appropriation Symbol and Subhead
30. Object Class
31. Bureau Control Number
32. Sub Allotment
33. Authorization Accounting Activity
34. Transaction Type
35. Property Accounting Activity
29. In the Cost Code(s) list, select the applicable code.

PART II - Marine Section

1. If applicable, check the Appellate Leave box. To use this entitlement, the required information must have been input into a leave computation module that determines the member's correct leave balance.

2. In the As of box, type the Effective Date of the appellate leave status, in YYYY/MM/DD format.

3. If applicable, select Voluntarily on Leave.

4. In the For Days box, type the 2-digit Number of days of voluntary appellate leave. Valid days are from zero to ninety, and the default value is zero.

5. If applicable, select Involuntarily on Leave.

6. In the For Days box, type the 2-digit Number of days of voluntary appellate leave. Valid days are from zero to ninety and the default value is zero.

7. If applicable, check the I Elect Payment Of box.

8. In the Days Lump-Sum Leave box, type the 2-digit Number of days to be paid for lump sum leave. The maximum number of days payable for lump sum leave is 60 days.

9. If applicable, check the I elect to be issued Government Transportation Request (s) box.

10. In the From box, the duty station is automatically populated from the ODSE database based on the member's RUC.

11. In the To box, type the Duty Station to which the member elected to be issued transportation requests.

12. If applicable, check the I elect to be paid advance separation travel allowances box.

13. In the From box, the duty station is automatically populated from the ODSE database based on the member's RUC.

14. In the To box, type the Duty Station to which the member elected to be issued transportation requests.

15. From the By list, select the Mode of Travel by which the member elected to travel to the new duty station. Auto is the default value.

16. In the Submit Claim To box, type the Complete Address of the disbursing office paying the advance.

17. In the Permanent Mailing Address box, type the member's Permanent Mailing Address, city and state, up to 100 characters.
18. In the EMail Address box, type the member's Email Address, up to 50 characters.
19. In the Contact Phone Number box, type the member's Emergency Contact phone number in (999)999-9999 format.

Diary Transaction Information

If anything is entered in this section, the Number field and the Date field are required to be entered by the Admin Preparer. It is not required by the Disbursing Preparer, but must be entered for the document to be certified.

1. In the Number box, type the five-digit diary Transaction Document Id number.

2. In the Date box, type the Diary Generated Date in YYYY/MM/DD format.

3. In the TTC box, type the three-digit TTC number.

4. In the SEQ box, type the three-digit TTCSEQ number.

5. In the Reported box, type the Description of the transaction up to 350 characters.

6. Choose Add Transaction. The Transaction is updated and displays beneath Add Transaction. A selected check box displays to the left of the transaction.

7. If you want to Delete a TTC Transaction, check the applicable Check Box. When the document is updated, the transaction no longer displays.

Other Options

1. Do one of the following:

2. To Add a Document, choose Add Document. The document is added to the database.

3. To Add a Document Comment to the document, choose Document Comment. The comment is attached to the current document.

4. To Add or Forward the document to the Certifier to be reviewed, choose Add/Forward for Review. The document is added to the database and forwarded to the appropriate section.

2. You return to the User Console page.

Duplicate Document

You can create another document by copying one and changing the SSN and any desired fields.

How Do I Get Here?

1. Begin on the desired NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization page.

2. From the document options menu, select Duplicate Document. The Input SSN page displays.

3. In the Service Code and SSN box, type the member's one-digit Service Code and nine-digit Social Security Number. Choose Create. A document that has the same options and comments as the original document displays for the new social security number. 

4. Change the desired fields and then make another selection from the document options menu. 

Leave Computation

This function allows you to input leave information for a member to compute the Leave Computation Balance and then provides updated leave totals to the Lump-Sum Leave, Leave Awaiting Separation, and Appellate Leave totals, which are used in the processing of the documents.

Add Document

This function adds the newly created document to the Document Tracking and Management System database.

Document Comment

You can add a comment each time you forward a document. This comment floats with the document, and you are allowed to change its contents until the document is returned, certified, killed, or closed by a Certifier, at which time the comment becomes a permanent portion of the document.

To Add A Comment

1. Choose Add Document Comment. The document comment box displays.

2. In the Comment box, type your comment, up to 4000 characters, including spaces, returns and punctuation.

3. Do one of the following:

4. To save your comment, choose OK. Your comment is attached to the document.

5. To exit the page without typing a comment, choose Cancel.

4. You return to the Document page.

Update Document

This functionality allows you to open, change, and save information on a document that is on the Document Tracking and Management System database.

Any document that is created by the unit and has not been closed, killed, or deleted is considered to be an open document for that unit.

How Do I Get Here?

1. Begin on the User Console page.

2. On the Record you want to change, choose the member's Name. The Document page displays.

To Update a Document Page

Once a document is updated, and depending on the loginELSIG, the following options (to the left of the page) provide a variety of options to continue the processing of the document.

1. On the Document page, update the applicable fields.

2. From the document options menu, Do one of the following:

· To Update a Document, select Update Document button. The document is added to the database.

· To Add a Document Comment to the document, select Document Comment. The comment is attached to the current document.

· To Add or Forward the Document to be reviewed, select Add/Forward for Review. The document is added to the database and forwarded to the appropriate section.

· To Attach Another Document to this document, select Attachments. The Attach Files page displays, and the document is attached to the current document.

· To Close the document, select Close Document. 

· To Delete a document, select Delete Document. The document is deleted from the database.

· To Duplicate Documents, select Duplicate Document. The Input SSN page displays and a duplicate document can be created.

· To Kill the document, select Kill Document. 

· To Return the Document to the Preparer, select Return to Preparer. The document is returned to the Preparer.

· To Return the Document to Admin, select Return to Admin. The document is returned to Admin.

· To Send the Document to the Reviewer, select Forward to Reviewer. The document is forwarded to the Reviewer.

· To Send the Document to the Certifier, select Forward to Certifier. The document is forwarded to the Certifier.

· To Update and Forward to Disbursing, select Update/Forward to Disbursing. The document is updated and sent to Disbursing. 
· To Update and Forward to NAMALA, select Update and Forward to NAMALA, the document is updated and sent to NAMALA.

· To View Attached Files, choose Attachments. The Attached Files page displays.

3. You return to the User Console page.

Attach Correction

This option is available only if a document has returned to the Admin section and enables you to return. Before you can attach a correction, the document must be forwarded to a certifier, updated to disbursing, forwarded for audit, and returned to the certifier and to admin. 

 

How Do I Get Here?

· From the NAVMC 11060 document or the NAVMC 11116 document, choose Attach Correction. The Attach Correction page displays.

To Include Correction Information

1. In the Instructions/Other box, type any correction information you want to include. 

2. Choose Add/Forward to Disbursing. The document page displays again.

3. Choose Forward to Audit. You return to User Console page.

Document History

This function allows you to view the events and status changes that occur to an electronic document during its life cycle and provides a link to the member's existing document.

 

Information is provided about the unit that created this document and the unit that it is currently assigned to. The date and time the document was last edited and the date the document was closed are also provided. The number of days the document has been in a working status, a list of the document history in the date and time order, with the newest time displayed first, are available. Displayed each time the document is processed are the Date and Time, the document action, the user's SSN and name, and if available, an attached comment.

 

The information for the document history is pulled from the Document Tracking and Management System Database, and the history statement list is sorted in descending order of date and time.  You may also attach a document from the history page, modify the document , and view any files attached to the document. If it was created by your unit, and you are a Disbursing or Admin Certifier level Authority ELSIG, or a Disbursing or Admin Preparer level Authority ELSIG, you can modify the document history.

 

How Do I Get Here?

1. Begin on the User Console page.

2. On the desired record, choose View History. The Document History page displays.

The following information displays:

Header

· User Name, of RUC or DSSN

· Title - Document History

Body

· Document ID

· Member Name

· Member SSN

· Originated By

· Currently Assigned To

· Last Updated

· Document Closed

· Hours Worked

At the Bottom

· Date

· Document Action

· By

· Comment

To Refresh the Document

To update the Document History page to the member's most current information, choose Refresh Report.
To Modify a Document From the Document History Page

Once you attach the document, depending on the login ELSIG and the status of the document, you can modify it.

· To modify a document, follow directions on the Update Document page, beginning in the How Do I Get Here? section, step 2.

To Print the Document

· On the record you want to print, choose Print Document. The document page displays.

Route Document

There are two ways to route the NAVMC 11116 and the NAVMC 11060, Forward and Return.

You can Forward To:

· Admin Reviewer

· Admin Certifier

· Disbursing Preparer

· Disbursing Auditor

· Disbursing Certifier

· NAMALA (Available only for the NAVMC 11060 document)

You can Return To:

· Admin Preparer

· Disbursing Preparer

· Disbursing Auditor

Return to Originating Admin

This option is available to the NAMALA Certifier. It is used to return the Appellate Leave document to the unit that created it.

How Do I Get Here?

· From the NAVMC 11060 document, choose Return to Originating Admin. The document is returned to the Admin pool of the office that created it.

Delete Document

This function allows you to delete a document from the Document Tracking and Management System database and returns you to the User Console. The document is no longer visible on any User Console.

To Delete A Document

1. From any document in the Document Tracking and Management System database, choose Delete Document. A message prompts you to confirm the deletion.

2. Do one of the following:

· To delete the document, choose OK. You return to the User Console.

· To cancel, choose Cancel.

Kill Document

Once an Admin Certifier or Disbursing Certifier has certified a document, it cannot be deleted. If it is determined to be an invalid document, the document must be killed, a process that closes it and removes it from the database. A document can be killed only by the Admin or Disbursing Certifier of the unit that generated it.

How Do I Get Here?

1. Begin on the User Console page.

2. On the Record you want to change, choose the member's Name. The Document page displays.

To Kill a Document

1. On the Document page, select the desired document.

2. Choose Kill Document. The document is killed.

Close Document

This function allows you to close the document when it has been completely processed and is no longer needed and if there is no further editing of the document necessary.

This option is only available for Admin RUCs.

 

How Do I Get Here?

1. Once the document has been forwarded for a disbursing audit, start from the User Console. 

2. Choose the Member Name for the desired NAVMC 11116 form. The NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization page displays.

To Close the Document

· Choose Close. You return to the User Console.

Attached Files

This page allows you to view the files attached to the Miscellaneous Military Pay Order or Special Payment Authorization document or the Travel Pay Certificate document.

How Do I Get Here?

1. Begin on the Attach Files page.

2. Choose Attach File(s). The Attached Files page displays.

The following information displays:

Header

· Title - Attached Files

Body

· Attached Date

· User Unit

· User Name

· File Name

· Attached Time

· Description of Attachment

To View the Attached Files

· Choose the File you want to view. The File page displays.

To Close the Attached Files

· Choose Close. You return to the Document page.

Choose File

This page allows you to search and select the file to upload or attach.

How Do I Get Here?

1. Begin on the ELSIG Upload page or the Attach Files page.

2. Choose Browse. The Choose File page displays.

To Choose a File

1. In the Look in box, select the desired drive and then the File you want to attach. The File displays in the File Name box.

2. Do one of the following:

3. If you find the file you want to attach, choose Open. You return to the previous page.

4. If you do not find the file you want to attach, choose Cancel. You return to the previous page.

Awaiting Zero-Balance

This page lists NAVMC 11060 documents that have been certified by a disbursing unit and must be set to a balance of zero. Only Disbursing Preparer, Disbursing Certifier, and Disbursing Auditor-level authority ELSIGs have access to this page.

How Do I Get Here?

1. Begin on the any Document Tracking and Management System page.

2. From the File menu, select Zero-Balance Documents. The Awaiting Zero-Balance page displays.

This page consists of the following information:

Header

· Title (NAVMC 11060 Documents Awaiting Zero-Balance)

Document Information

· Date Document Closed

· SSN

· Member Name

Footer

· Number of documents awaiting zero balance. 

To View the Document

· Choose the Member Name on the desired record. The Document page displays.

Note:If the document is an Advisory Notice, then zeroes display under SSN and Advisory Notice displays under Member Name.

To View the Document History

· Choose View History on the desired record. The Document History page displays.

To Print a Document Page

· On the record you want to print, choose Print Document. The Document page displays.

To Return Documents for Rework

1. Select the documents you want to return.

2. Choose Return for Rework. You return to the User Console page. The Return to Admin option is not available for these accounts.

To Forward for Zero-Balance Audit

1. If you are logged in as a disbursing auditor, select the documents you want to forward.

2. Choose Forward for Zero-Balance Audit. You return to the User Console page. The selected accounts are no longer visible. 

To Forward for Zero-Balance Certification

1. If you are logged in as a disbursing reviewer, select the documents you want to forward.

2. Choose Forward for Zero-Balance Certification. You return to the User Console page. The selected accounts are no longer visible. 

To Certify Zero-Balance

1. If you are logged in as a disbursing certifier, select the documents you want to certify.

2. Choose Certify Zero-Balance. You return to the User Console page. The selected accounts have been routed to DSSN D0003.

To Close a Document

1. If you are working in the DSSN D0003 RUC, select the documents you want to certify.

2. Choose Close Document. You return to the Awaiting Zero Balance page. The selected accounts have a different Date Document Closed and have a status of zero-balance.

Note: This option is not available for accounts with an appellate leave status.

Advisory Notice

An advisory notice is created for a RUC, by the Disbursing Office (DO) to notify the Admin Office to start an action on member's records. It is added to the Document Tracking and Management System database and can be edited until it is forwarded for review. The Disbursing Preparer, Disbursing Auditor, and the Disbursing Certifier-level Authority ELSIGs have access to this function.

How Do I Get Here?

1. Begin on the any Document Tracking and Management System page.

2. From the File menu, select New Document and then choose Advisory Notice. The Advisory Notice page displays.

This page consists of the following information:

Header

· Title (Advisory Notice from DSSN: )

· RUC

To Create an Advisory

1. In the RUC box, type the applicable RUC.

2. In the Comments box, type the advisory notice.

3. From the document options menu, do one of the following:

4. Select Add Document. The advisory is added to the database.

5. Select Add/Forward for Review. The advisory is added to the database and is forwarded for review.

4. You return to the User Console page.

To View the Advisory Notice Document

1. To display the Advisory for a document, choose Advisory Notice under the Member Name column. The applicable Document displays.

2. Do one of the following:

3. To Add a Comment to the document, select Document Comment. The comment is attached to the current document.

4. To Delete a Document, select Delete Document.

5. To Update a Document, select Update Document. 

6. To Update or Forward the document to the Certifier to be reviewed, choose Update Document or Forward for Review/to Certifier. The document is added to the database and forwarded to the appropriate section.

To View the History

· To view the advisory history, choose View History on the desired advisory. The View History page displays.

To Print the Advisory

1. To print the advisory, from the browser File menu, choose Print. The Browser Print window opens.

2. Choose the desired Options.

3. Choose Print. The document prints.

4. You return to the previous page.

Final Settlement Comment

This page allows the Disbursing ELSIG to add information for zero balance certification of a document. Only Disbursing Preparer, Disbursing Certifier, and Disbursing Auditor-level authority ELSIGs have access to this page.

How Do I Get Here?

· Begin on the Awaiting Zero Balance page. Choose Forward for Zero Balance Audit. The Final Settlement Comment page displays.

To Add a Final Settlement Comment

1. In the Final Settlement Comment box, type the desired information.

2. Do one of the following:

3. If you want to forward the comment, choose OK. The comment is saved and forwarded with the document for processing.

4. If you do not want to forward the comment, choose Cancel. The information is canceled and you return to the previous page.

View Attached Files

This page allows you to view all attached documents.

How Do I Get Here?

1. Begin on any NAVMC 11060 or NAVMC 11116 document.

2. Choose Attachments. The Files Currently Attached page displays.

To View Attached Files

1. Choose the Attachments option. The Files Currently Attached page displays.

2. Choose the Attached date or Attached By/File Name. The attached Document page displays.

3. Choose Close. You return to the Document page.

Print Document

Any Document Tracking and Management System document or attached document can be printed from the document page.

How Do I Get Here?

1. Begin on the Document or Report you want to print a document from.

2. On the Record you want to print, choose Print Document. The document displays.

To Print a Document

1. From the browser File menu, choose Print.  The Browser Print window opens.

2. Choose the desired Options.

3. Choose Print. The document prints.

4. You return to the previous page.
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